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RELEASE NOTES Version 1123A

RELEASE NOTES FOR PATHPILOT V2.10.0
Fall 2023

ENHANCEMENTS

All

We added:

l Support for a new on-screen keyboard. (PP-3497) For more information, see "On-Screen Keyboard"
(page 10).

l Support for USB cameras. For more information, see "USB Camera" (page 3).

l “Dashcam” automatic 30 second video recording prior to hitting the emergency stop button. (PP-3525)

l Manual video recording and image capture.

l Video recording and image capture through the addition of three new M-codes.

l A new M00/M01 workflow to simplify the creation of image files that can be shown during pause. (PP-
3526)

l A new screen layout for portrait (vertical) orientation on 1920 × 1080 widescreen monitors. (PP-3522) For
more information, see "Portrait Screen Layout" (page 8).

l Block delete functionality. You can now prefix any line of G-code with a slash (for example, /G0 X0Y0Z0).
When you select the Block Delete button (toggle it on), PathPilot skips any line that begins with a slash (/). If
Block Delete is toggled off, the lines execute as normal. (PP-3978)

Mills

l We split the Coolant button into a Flood and a Mist button on M, M+, and MX mills. For instructions on
adding an additional mist outlet on your existing 1100/770 mill, refer to Tormach document SB10828. (PP-
4139)

FIXED ISSUES

All

l We fixed an issue where saving files with a quotation mark (") in the name prevented the file from loading.
(PP-3701)

https://tormach.com/docs/download/assetlink/asset_id/749


Mills

l We fixed an issue where incorrectly scaled feed rate values were shown in the DRO with G21 active during a
pure A-axis motion. (PP-4115)

Lathes

l We fixed an issue where, in rare situations, the spindle on the 8L didn't stop when the enclosure door was
opened. (PP-4091)
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OVERVIEW

USB CAMERA
OVERVIEW

Recording video and audio from USB cameras is supported in PathPilot v2.10.0 and later. You can use up to four
cameras simultaneously to record from different vantage points.

Note: All cameras are started and stopped at the same time — if you don't want a camera to record, you
must unplug it.

USB cameras are compatible with all machine types, but older controllers may lack the processing power and
memory needed for camera support. Controllers require 4GB of memory for camera functionality. Use the ADMIN
MEMORY MDI command to verify the memory size of a controller.
You can purchase a Tormach USB Camera (PN 51240) with a metal case, mounting bracket, and 15-foot USB cable.
Other USB cameras may work (see below), but do not include any technical support.

GETTING STARTED

After plugging in the USB camera, navigate to the camera settings. From the PathPilot interface, in the Settings
tab, open the Camera(s) tab. Identify the Camera Status read-only dialog box.

As cameras are plugged in and unplugged, the Camera Status area is refreshed. To test compatibility of any USB
camera, plug it in and watch the Camera Status area for the camera name and details.

Note: If a camera isn't shown after plugging it in or starting a video recording, it might require too much
power from the USB ports on the controller. This is very likely when more than one camera is used. Try
using a powered USB hub to add the camera(s).

When a USB camera is plugged in, it's analyzed for supported video and audio formats, frame sizes, and frame
rates. If the camera supports it, PathPilot uses H.264 compression; otherwise, it uses Motion JPEG.
If the USB camera has a microphone, PathPilot records audio as well as video. The preferred format is compressed
AAC, but uncompressed PCM is used as a fallback.
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RECORDING VIDEOS AND AUDIO

RECORDING VIDEOS AND AUDIO

The cameras can only be used for automatic E-stop loop recording or manually controlled recording, but not both
at the same time.

Manual Recording

To start or stop a manual recording, either:

l Use the controls in the Manual Recording area of the Camera(s) tab.
When a manual recording is stopped, a file save-as dialog appears prompting you for the file name base to
use.

l Select the Video Camera Recording button in the Persistent Controls section.

Whenever PathPilot is recording from a USB camera and/or the virtual screen camera, the LED on this
button is green. If PathPilot is recording and the button is pressed:

l If a program is running and not paused at an M00/M01, the recording is aborted.

l If a program is not running, but the machine is moving, the recording is aborted.

l Otherwise, if a manual recording is in progress, it is stopped and a file save as dialog will appear. If an
automatic e-stop loop recording is in progress, it is aborted since no e-stop occurred.

To include a screen recording:
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RECORDING VIDEOS AND AUDIO

1. Toggle the Include PathPilot screen in recordings checkbox in the Camera Settings area of the Camera(s)
tab to enable or disable screen recording.

To take a picture (using all of the USB cameras at once):

1. Select Snapshot in the Manual Recording area of the Camera(s) tab.
The Main tab displays.

2. Review the camera images, which display on top of the Tool Path area. The camera images refresh every
0.5 seconds.

3. Align the cameras or adjust lighting to your preference, and then select the Shutter button.

Automatic E-Stop Loop Recording ("Dashcam")

E-stop loop recording enables analysis of the previous 30 seconds after an E-stop. When enabled, recording is
automatically started after reset.
To enable or disable the recording of emergency stops:
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G-CODE COMMANDS

1. Toggle the Automatic e-stop loop recording checkbox in the Camera Settings area of the Camera(s) tab.

Note: This feature is enabled by default.

Automatic E-stop loop recording starts when the Reset button is selected. If you selected Video Camera
Recording to abort a previous E-stop loop recording, select Reset to start it again.

To view E-stop videos:

1. A slight delay occurs after an E-stop while the video is saved to the E-stop Videos folder. Select the video
file, and then select Load G-Code to view it.

Note: The E-Stop Videos folder is automatically monitored for internal drive space use. If the folder
size grows beyond 5 GB, the oldest video files are automatically deleted until the folder size
becomes less than 5 GB.

Reviewing Video and Image Files

1. On the File tab, select the video or image file and select Load G-Code.
A video player application starts or the image preview is displayed.
Alternatively, you could transfer the video or image files to a Windows or macOS computer for review.

File Naming Convention

For manual and automatic E-stop recordings, the base file name for the recording has automatically chosen
suffixes appended for each camera.
For example, if you stop a manual recording of two cameras, specify “Left Bracket Op1” as the name, and enabled
screen recording, you'll see the following files:

File Name Description of File

Left Bracket Op1_0.mp4 Camera 0 mp4 video file

Left Bracket Op1_0.log Troubleshooting log for camera 0

Left Bracket Op1_1.mp4 Camera 1 mp4 video file

Left Bracket Op1_1.log Troubleshooting log for camera 1

Left Bracket Op1_PP.mp4 PathPilot screen recording mp4 video file

Left Bracket Op1_PP.log Troubleshooting log for screen recording

G-CODE COMMANDS

PathPilot supports three new M-codes to control cameras within G-code programs: M301, M302, and M303.
Example use cases:

l Record only across each M01 stop where the operator needs to flip a workpiece or change a tool.

l Create short videos that focus on unique aspects of the program to reduce later video editing.
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G-CODE COMMANDS

l Record USB IO integration operations with robots or other devices (pneumatic vises, etc.).

l Monitor progress on a workpiece by including M303 throughout the program.

File Naming Convention

Recordings or pictures created by M301/M302/M303 have automatically generated file names, with the base file
name taken from the running G-code file. Video files are saved alongside the G-code file. The suffix for each file
uses a time stamp format. This makes it easy to distinguish multiple runs of the same G-code program.
For example, if engrave.nc is running and uses M301 and M302 to create one recording on a machine with one
camera, and screen recording enabled, you'll see the following files:

File Name Description of File

engrave_2023-02-21_16_58_33_0.mp4 Camera 0 mp4 video file

engrave_2023-02-21_16_58_33_0.log Troubleshooting log for camera 0

engrave_2023-02-21_16_58_33_PP.mp4 PathPilot screen recording mp4 video file

engrave_2023-02-21_16_58_33_PP.log Troubleshooting log for screen recording

engrave_2023-02-21_17_43_22.jpg Picture taken by a single M303 later in the program

M01 G-Code Command for Setup Pictures

Previously, PathPilot supported annotating the M01 optional break with a comment that could contain a picture
file name, a video file name, or instructional text. With the camera feature, you can now take setup pictures with
the M01 feature.
To use M01 for setup pictures:

1. Add M01 (op1_setup.jpg) into your G-code program.

2. Run the G-code program.

3. When PathPilot executes the M01 it looks to see if the comment contains a file name.

l If there isn't a file name: The comment is shown as instructional text across the tool path.

l If there is a file name, but the file doesn’t exist yet and the extension is .jpg, .png, or .jpeg: The USB
cameras are initialized and shown in the tool path display.

4. Select the Shutter button to take the picture and create the op1_setup.jpg file.
In future runs of the G-code program, op1_setup.jpg will display to the operator for instructional purposes
on the workpiece.
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OVERVIEW

PORTRAIT SCREEN LAYOUT
OVERVIEW

A vertical orientation for 1920 × 1080 monitors is supported in PathPilot v2.10.0 and later.
Portrait layout provides some key advantages:

l A larger tool path window that's always visible at the top of the screen, regardless of which tab you have
active.

l A wider G-code window to more easily read the loaded G-code file and, if enabled, line numbers.

l The tool path window's view options are always visible for much easier access.

l When browsing g-code files using the File tab, file previews display on the top portion of the screen.
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CHANGING THE SCREEN ORIENTATION

CHANGING THE SCREEN ORIENTATION

1. From the PathPilot interface, on the Settings tab, select Portrait from the Layout drop-down menu. Restart
the controller.

2. Rotate the monitor to the portrait orientation. You can rotate it either left or right, depending on what's
easier for your setup.

3. While the controller is restarting, specify which direction you've rotated the monitor. Select Apply. If the
result is unexpected, click Restore Previous Configuration on the confirmation dialog and choose a rotation
direction again.

The controller restarts in portrait layout.
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OVERVIEW

ON-SCREEN KEYBOARD
OVERVIEW

A new on-screen keyboard is supported in PathPilot v2.10.0 and later.
The new keyboard provides some key advantages:

l Wider range of keys represented: both uppercase and lowercase, symbols, arrow keys, caps lock, backspace
and delete, etc.

l Works anywhere in the user interface where keyboard input is required.

l Resizable so you can tune the size to your visual and dexterity needs.

USING THE ON-SCREEN KEYBOARD

1. From the PathPilot interface, on the Settings tab, select the Soft / On-Screen Keyboard checkbox.

2. To resize the keyboard, select a corner of the keyboard and drag.
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USING THE ON-SCREEN KEYBOARD

3. To reposition the keyboard, select the Anchor key and drag the keyboard anywhere on the screen.

4. To close the keyboard, select the X key.
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DOWNLOAD AND INSTALL AN UPDATE FILE FROM THE CONTROLLER

MANAGE PATHPILOT VERSIONS
You don't need to install updates sequentially. You can update from any previous version to the current version of
PathPilot. Depending on what you want to do, refer to the following sections:

l "Download and Install an Update File from the Controller" (below)

l "Install an Update File from a USB Drive" (on the next page)

l "Install a Previous Version of an Update File" (page 15)

DOWNLOAD AND INSTALL AN UPDATE FILE FROM THE CONTROLLER

1. Confirm that the PathPilot controller is powered on and out of Reset mode.

2. Downloading and installing an update file requires an Internet connection. From the Status tab, confirm that
the Internet button LED light is on. Then, select Update.

Figure 1: Update button on the Status tab.

3. From the Software Update dialog box, select Check Online.

Figure 2: Software Update dialog box.
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INSTALL AN UPDATE FILE FROM A USB DRIVE

4. Select Install.

Figure 3: Install button on the Software Update dialog box.

The update file is downloaded, and a notification dialog box displays.

5. From the dialog box, select OK.
The update file is installed on the PathPilot controller.

6. Follow the on-screen instructions to restart the PathPilot controller.

INSTALL AN UPDATE FILE FROM A USB DRIVE

1. From the PathPilot support center, download the most recent PathPilot update file.

2. Transfer the PathPilot update file to a USB drive.

3. Put the USB drive into the PathPilot controller.

4. Confirm that the PathPilot controller is powered on and out of Reset mode.

5. From the Status tab, select Update.

Figure 4: Update button on the Status tab.
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INSTALL AN UPDATE FILE FROM A USB DRIVE

6. From the Software Update dialog box, select Browse.

Figure 5: Software Update dialog box.

7. From the Browse dialog box, select USB.

Figure 6: Browse dialog box.

8. Select the desired update file, and then select Update.
The update file is installed on the PathPilot controller.

9. Follow the on-screen instructions to restart the PathPilot controller.
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INSTALL A PREVIOUS VERSION OF AN UPDATE FILE

INSTALL A PREVIOUS VERSION OF AN UPDATE FILE

1. Confirm that the PathPilot controller is powered on and out of Reset mode.

2. From the Status tab, select Update.

Figure 7: Update button on the Status tab.

3. From the Software Update dialog box, select Browse.

Figure 8: Software Update dialog box.

4. From the Browse dialog box, select Previous Versions.

Figure 9: Browse dialog box.

5. Select the desired update file, and then select Update.
The update file is installed on the PathPilot controller.

6. Follow the on-screen instructions to restart the PathPilot controller.
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